
2022-2023 
NursingCAS Walkthrough

By: Casey Ellis



Table of Contents
Important Detail……...4
Application Tips……….5
NursingCAS Timeline...6
Starting the App……….7
Etiquette………………….8
Background Checks…...9
Fees & Waivers……10-12
Coupon Codes …….13-14
Account Creation…..15-16
Adding Programs………17
Application Process…...18
Personal Information…19
NursingCAS Release…..20
Advisor Release………….21
Biographic Info……….22-23
Contact Information…24-25
Citizenship Info……….26-27
Visa Information………….28
Academic History………….29
High School…………………30
Colleges Attended………31-32



Table of Contents Continued
Transcript Entry…………………………33-39
Professional Transcript Entry……….39-40
Standardized Tests…………………….41-42
Supporting Information………………….43
Achievements………………………...…44-46
Licenses and Certifications……….…47-49
Experiences………………………………50-52
Program Materials…………………….53-55
References……………………………….56-60
Kira Assessment……………………………61
Program Prerequisites……………………62
NursingCAS Contact Info………………..63
When to contact a program………….…64
Conclusion……………………………………65



Important Details

• The NursingCAS application will open on July 1st.

• Record your username and password in a secure and 
convenient location.

• Print your completed application for your records before 
submitting it to NursingCAS. Do not send the printed 
application via mail.

• Make sure to apply based on individual program 
deadlines.



Helpful Application Tips
•Do not enter your coursework from memory—Use your transcripts!

•Do not wait for nursingCAS to receive all materials before 
submitting your application.

•Do not wait for nursingCAS to receive all your materials before 
you submit your application.

•Complete the "Colleges Attended" section of the application first. 
Nursingcas cannot post transcripts to your application until this step 
is done.

•Consistently check status of your transcripts, references, test scores, 
and any forms.

•Arrange for all materials to arrive by the deadline.

•Check your email daily for important messages from nursingCAS
and programs.

•Review your application for accuracy before submitting the 
application.



NursingCAS Timeline



Before Starting the NursingCAS Application:

Prior to applying you will want to research programs you wish to apply to. 

Pay special attention to:

➢ Cycle dates and deadline requirements. In some instances, the individual 
program's deadline may differ from the application's cycle dates. 

➢ Application fees. Some programs may have a supplemental fee; contact 
your programs to learn if they require this and how to pay it. 

➢ Evaluation requirements. 
➢ Minimum requirements, including prerequisites, standardized test scores, 

supplemental applications, foreign evaluations, etc. 



A Note about Etiquette

NursingCAS expects all applicants to exhibit 
professionalism when contacting customer service. 
Applicants must identify themselves properly and 

honestly, as information cannot be provided to parents, 
spouses, family members, or friends. Misrepresentation of 

identity and/or dishonest, threatening, or offensive 
communication will not be tolerated.



NursingCAS Background Checks
Overview
Background checks vary widely from program to program. Some programs require 
applicant background checks prior to acceptance, while others require these checks 
as a condition of matriculation. For questions about background checks – including 
when in the application process this must be completed – contact each of your 
programs directly.
Background checks reflect all prior convictions, guilty pleas, city ordinance citations 
(such as public intoxication), illegal possession(s) including possession of alcohol 
under the legal age, payments of fines (including those for traffic violations), and in 
some cases, prior records thought to have been expunged. Note that in some 
states, common traffic violations can be considered misdemeanors.

Programs that Require Background Checks
Programs that require a background check will often initiate this process after you 
have submitted your application; they use a vendor such as Castle Branch (note: 
you should contact your programs directly for specific details). Each program that 
uses Castle Branch will send you an email with instructions on how to complete 
your background check.
If you are using Castle Branch and need assistance, it may be helpful to contact 
their customer service.

https://www.castlebranch.com/
https://www.castlebranch.com/contact-us


Fees & Fee Waivers
Fees

NursingCAS charges the following application fees:

Undergraduate Programs

$55 for the first undergraduate-level program and $40 for each additional 
program.

Graduate Programs

$75 for the first graduate-level program and $45 for each additional 
program.

2021-2022 Fee Assistance Program

Beginning at the start of the cycle, a limited number of fee waivers are 
provided to qualified applicants on a first-come, first-served basis. Each fee 
waiver covers only the initial application fee, so if you wish to apply to 
additional programs, you are responsible for the remaining balance. If you 
received a fee waiver during a previous cycle, you may still apply for another 
in the next cycle.

You may request a fee waiver as soon as you create an application, but keep 
in mind that fee waiver funds can be quickly depleted. Contact customer 
service at 617-612-2880 before you submit a fee waiver request to 
determine if waivers are still available.

tel:+16176122880


Fee Waiver Qualification 
Requirements:

There are two types of fee waivers applicants can qualify for:
•Income-based
•Service-based
You can only apply for one type of fee waiver per cycle. Additionally, you must 
request a fee waiver before you submit your application. Requests received after an 
application has been submitted will not be honored.
If you are approved for a fee waiver, you are required to submit your application 
within 30 days (including holidays and weekends). Extensions will not be granted; 
failure to submit your application on time will void your fee waiver and you will not 
be allowed to reapply for a waiver.
Financial Based Fee Waiver
To qualify for an income-based fee waiver, you must have either:
•Filed a 2020 Federal Income Tax Return Form 1040 with an adjusted gross income 
that falls below the Low-Income Level listed below, or
•Been listed as a dependent on a filed 2020 Federal Income Tax Return Form 1040 
with an adjusted gross income that falls below the Low-Income Level listed below. If 
you were claimed as a dependent by a parent or guardian on their 2020 Federal 
Income Tax Return, NursingCAS requires you to use that individual's Federal 
Income Tax Return instead of your own.



Service-Based Fee Waiver

To qualify for a service-based fee waiver, you must 
have participated in one of the eligible service-based 
organizations:

•Active AmeriCorps Volunteer

•McNair Scholar

•Peace Corps In-Country Volunteer or Alumni

Click on the organization above to download the fee 
waiver form. Complete the form, and if necessary, also 
have a certifying officer or program administrator 
complete their section of the form.

https://help.liaisonedu.com/@api/deki/files/178605/NursingCAS_Service_Waiver_Request_AmeriCorps_2022.pdf?revision=2
https://help.liaisonedu.com/@api/deki/files/178607/NursingCAS_Service_Waiver_Request_McNair_2022.pdf?revision=2
https://help.liaisonedu.com/@api/deki/files/178606/NursingCAS_Service_Waiver_Request_Peace_Corps_2022.pdf?revision=2


Coupon Codes

Some programs provide coupons that offset application fees. If 
you received a coupon code from your program, use the 
information below to apply it to your payment.
Note that coupon codes cannot be redeemed after an 
application has been submitted. Additionally, if you miss a 
program deadline due to waiting for a coupon code, you must 
request a deadline extension from your program, not 
NursingCAS.



Using a Coupon Code

You can apply your coupon code(s) when you are ready to submit your application.
1.Click the Submit Application tab at the top of the application.
2.Click Submit, or to submit to more than one program, click Submit All.
3.On the payment page, enter the coupon code(s) you received from the 
program(s) under Apply Coupon.
4.Click the Apply Coupon button.
5.Complete the rest of the payment details pages.
Note the following:
•When a coupon code equals the total transaction amount, you don’t need to enter 
additional payment information.
•When a coupon code is less than the total transaction amount, you'll need to enter 
payment information for the additional balance.
•When a coupon code is more than the total transaction amount, you don’t need to 
enter additional payment information. However, you'll forfeit the remaining balance 
offered by the coupon code, as NursingCAS will not issue credits or carry remaining 
balances forward.
•Coupon codes cannot be applied to chargeback fees.
If you used a coupon code when submitting to a program, the code will be listed 
under Payment History.



Account Creation

• To begin, click the “Create an Account” button 
on the NursingCAS application homepage. Enter 
a username, password, security question, and 
valid contact information. Click on the “Create 
My Account” button to activate a new account 
and unique NursingCAS identification number. 
You are not permitted to create more than 1 
NursingCAS account per application cycle! 
Duplicate accounts will result in significant 
processing delays and problems with application 
materials! NursingCASwill delete duplicate 
accounts, including associated documents!



Account Creation 

Note: there is no cost for account creation; 
applicants are not charged until they select 

programs and submit their application. 
When creating an account, You will be prompted 

to submit the following information: Name, 
Contact Information, Username and Password, 

Agreement of Terms of Service.



Add A Program
1.Click Add Program at the top of the application home page.

2.Use the filters to locate the programs you are interested in applying 
to.

3.Click the plus sign next to a program to add it to your program list. If 
you want to remove a program and only have one selected, you need 
to add the second program before you can remove the first one.

4.Continue adding programs as desired.

5.Begin filling out the application. Before submitting, be sure to review 
your program list to make sure you are applying to all your intended 
programs.

Note that by submitting your application, you are committing to 
applying to your selected programs. You cannot substitute or remove 
submitted programs after submissions. Additionally, we do not offer 
refunds for selections made in error and we do not transfer payments 
to another program.

After submission, you can continue to add and apply to programs until 
the final deadline date.



Application Process:

NOTE: The Personal Information, Academic History, and 
Supporting Information sections contain data elements 
and questions common among participating programs. 
These sections are the centralized, common elements of 

the application. Each school and program is able to 
collect additional information from applicants if more 

information is needed for their applicant review process. 
This additional information is unique to each program 
and is displayed to applicants in the Program Materials 

section of the application.



Personal Information

This section is used to gather your biographic 
and contact information, as well as citizenship, 
race/ethnicity, and other family information.



NursingCAS Release 
Statement

Overview

In this section, you must review and respond to the following release 
statements in order to submit your application. Once you submit your 
application, your responses cannot be edited. Please review these 
instructions and the content of the statements carefully. It is your 
responsibility to read and understand these statements before 
responding to them. If you have any questions regarding these 
statements, contact customer service at 617-612-2880 for clarification 
before making your selections.

Release Statement

This statement serves as a contractual agreement between you and 
NursingCAS. You must agree to these terms in order to submit your 
application.

Click the checkbox to acknowledge the accuracy of the information 
provided in your application.

tel:+16176122880


Advisor Release

Selecting Yes for this release allows NursingCAS to release certain 
information to health profession advisors and health profession 
advisory committees at schools you previously attended. This 
information includes some application information, including your 
GPA, the names of the nursing programs to which you applied, and 
which program, if any, you matriculate into. They will not see 
documentation such as transcripts or letters of reference.

If you select No, NursingCAS will not release your information to 
advisors. We encourage you to authorize this release, as it is useful 
to advisors assisting you and other future applicants; however, it 
will not affect the consideration given to your application.



Biographic Information
Your Name

This section pulls in information you entered when you created your account. 
Confirm that what appears here is correct; click the Profile Section link to make 
changes.

Alternate Name

If you are sending any documentation or test scores where your name is listed 
differently than it appears on your application, select Yes in this section and enter 
the alternate information. This ensures that your documents and test scores are 
matched to your application. Contact customer service so they can manually match 
these items to your application; failure to do so could cause significant delays.

Examples of alternate names include:

•Birth names (if different from current legal name)

•Maiden names

•Nicknames (e.g., "Bob" for Robert, "Beth" for Elizabeth, etc.)

•"Westernized" names

•Alternate punctuation (e.g., your name appears with/without a hyphen, 
apostrophe, or diacritical marking)

•Alternate spacing (e.g., your name appears with or without specific spaces)

•Known misspellings (if a document contains a misspelling)



Biographic Information 
Continued
Gender

Select the appropriate option. This information is required for reporting purposes to the US Federal 
government, using these values only.

Gender Identity

The American Association of Colleges of Nursing (AACN) and its member nursing programs recognize 
the importance of diversity and inclusivity in the student body and workforce. Select the gender 
identity option that you feel best describes you. This information is used for statistical purposes only, 
and in no way affects your application or financial aid eligibility.

Birth Information

Enter your date of birth in MM/DD/YYYY format. For example, January 7, 1989, would be listed as 
01/07/1989. Make sure you enter your date of birth correctly; failure to do so could cause significant 
delays with matching documentation and test scores.

Then, enter your country, city, state/territory/province, and county of birth. If you are unsure of your 
county of birth, select N/A.

Note: to ensure applicants are entering consistent data for some questions, this application uses pre-
populated answer options that are maintained by the International Organization for Standardization 
(ISO). For example, country answer options are derived from ISO 3166, which is the international 
standard for country codes and codes for their subdivisions.

https://www.iso.org/home.html
https://www.iso.org/iso-3166-country-codes.html


Contact Information

Current Address

Enter the address where you want to receive mail 
correspondence. Be sure to keep this section up-to-date as 
you complete and submit your application. If you anticipate a 
change of address, enter the date through which your current 
address is valid.

Note: to ensure applicants are entering consistent data for 
some questions, this application uses pre-populated answer 
options that are maintained by the International Organization 
for Standardization (ISO). For example, country answer 
options are derived from ISO 3166, which is the international 
standard for country codes and codes for their subdivisions.

If you don’t have a mailing address, you can list the address of 
a relative or friend, with their permission. If you find more 
permanent housing in the future, please update it in your 
application and with the programs you applied to.

https://www.iso.org/home.html
https://www.iso.org/iso-3166-country-codes.html


Contact Information 
Continued
Permanent Address

If your current address is different from your permanent address, select No under Is 
this your permanent address? Then, enter the address that you consider to be your 
permanent and/or legal residence.

Note: to ensure applicants are entering consistent data for some questions, this 
application uses pre-populated answer options that are maintained by 
the International Organization for Standardization (ISO). For example, country 
answer options are derived from ISO 3166, which is the international standard for 
country codes and codes for their subdivisions.

Phone Number

Your phone number pulls in from the information entered when you created your 
account. Verify that the listed phone number and type are correct; click the Profile 
Section link to make changes.

Email

Your email address pulls in from the information entered when you created your 
account. Verify that what appears here is correct; click the Profile Section link to 
make changes.

https://www.iso.org/home.html
https://www.iso.org/iso-3166-country-codes.html


Citizenship Information
United States Citizenship Details

Select your US citizenship status and country of citizenship, if applicable. If you have 
dual citizenship, indicate your second country of citizenship.

When selecting your status, consider the following definitions which are adapted 
from the US State Department:

•US Citizen: an individual who was born in the US or attained citizenship through 
naturalization.

•Permanent US Resident: an individual who holds a Green Card and is permitted to 
permanently live and work in the US.

•Temporary US Resident: an individual who is an alien – a nonimmigrant foreign 
national – who is approved to temporarily live in the US for a specific purpose (e.g., 
as a student), has a permanent residence abroad, and does not hold a Green Card.

•Non-resident: an individual who is a nonimmigrant foreign national and who is 
permitted to travel in the US for tourism or business for stays of 90 days or less.

•None: an individual who has no US citizenship or visa (immigrant or nonimmigrant) 
status.

Note: to ensure applicants are entering consistent data for some questions, this 
application uses pre-populated answer options that are maintained by 
the International Organization for Standardization (ISO). For example, country 
answer options are derived from ISO 3166, which is the international standard for 
country codes and codes for their subdivisions.

https://www.uscis.gov/greencard
https://www.uscis.gov/tools/glossary
https://www.uscis.gov/tools/glossary
https://travel.state.gov/content/travel/en/us-visas/tourism-visit/visitor.html
https://www.iso.org/home.html
https://www.iso.org/iso-3166-country-codes.html


Citizenship Information 
Continued
Residency Information

Provide your residency information, including your 
legal state of residence.

Visa Information

If you currently have a US Visa, select Yes and enter all 
visa information. Please note that we cannot advise 
you on your visa status or any related details.

When selecting your visa type, consider the following 
definitions which are adapted from the US State 
Department.



VISA Information List

Note that this list is not all-inclusive. Refer to the US State Department for more information.

•B-1 Visitor: an individual who wants to enter the US temporarily for business.

•F-1 Student: an individual who wants to study at a US academic institution. This is the most common 
student visa type.

•H1-B Employee: an individual who wants to work in the US in a specialty occupation.

•J-1 Student: an individual who wants to study at a US academic institution. This is generally used for 
students in educational exchange programs (e.g., Fulbright Program).

•J-1 Teacher, Researcher, or Trainee: an individual who wants to teach at a US primary or secondary 
school, research at a US institution, or train in an occupational field at a US business.

•Refugee: an individual who is located outside of the US, is of special humanitarian concern to the US, 
demonstrates that they were persecuted or fear persecution due to race, religion, nationality, political 
opinion, or membership in a particular social group, is not firmly resettled in another country, and is 
admissible to the US.

•Visa Waiver WB: an individual from a Visa Waiver Program (VWP) participating country that allows 
travel to the US for business stays of 90 days or less without obtaining a visa.

•Visa Waiver WT: an individual from a Visa Waiver Program (VWP) participating country that allows 
travel to the US for tourism stays of 90 days or less without obtaining a visa.

•Other: an individual who has received a visa type not listed. Note that this list is not all-inclusive and 
more visa types may be available in the application.

https://travel.state.gov/content/travel/en/us-visas/visa-information-resources/all-visa-categories.html
https://travel.state.gov/content/travel/en/us-visas/tourism-visit/visitor.html
https://travel.state.gov/content/travel/en/us-visas/study/student-visa.html
https://travel.state.gov/content/travel/en/us-visas/employment/temporary-worker-visas.html
http://j1visa.state.gov/programs/college-and-university-student/
https://j1visa.state.gov/programs/teacher
https://j1visa.state.gov/programs/short-term-scholar/
https://j1visa.state.gov/programs/trainee/
https://www.uscis.gov/humanitarian/refugees-asylum/refugees
https://www.uscis.gov/working-united-states/temporary-visitors-business/wb-temporary-business-visitor-under-visa-waiver-program
https://travel.state.gov/content/travel/en/us-visas/tourism-visit/visa-waiver-program.html


Academic History

This section is where you input the high schools and 
colleges you attended, as well as any coursework 
completed. Additionally, you can provide information 
about tests you have taken or plan to take, such as the 
GRE, MCAT, or TOEFL.

This part can be very tedious and time consuming. 
It is important that you allocate plenty of time to 
complete these sections in their entirety before 
moving on or taking a break. 



High School Attended
1.Click Add Your High School.

2.Enter the name of your high school, the city 
and state where it is located, and graduation 
date, if applicable.

1. If you attended multiple high schools, only 
list the high school that you graduated and 
received a high school diploma from.

2. If you attended a high school outside of the 
United States, select International from 
the States drop-down.

3. If you received your GED, please list GED as 
the name of the high school you attended, 
and the city/state which awarded your GED 
degree.

3.Click Save This School.



Colleges Attended
•Report all institutions attended regardless of their relevance to the programs 
you are applying to. Failure to report an institution may cause delays in the 
processing of your application. Report all institutions attended, including but not 
limited to:

• courses taken in high school for college or university credit

• summer courses

• community college courses

• US military academies (note that this does not include courses on 
SMART or JST transcripts)

• post-baccalaureate, graduate, and doctoral work

• study abroad, Canadian, and foreign work, etc.

•List all institutions on your application even if the coursework completed there 
was transferred to another institution.

•Report each institution only once, regardless of the number of degrees earned or 
gaps in the dates of attendance.

•Send official or upload unofficial transcripts. Your selected programs may have 
different requirements for transcripts. For example, some programs may require 
that you send official transcripts to NursingCAS, some may require unofficial 
transcripts, and others might not require any transcripts. To view your program's 
transcript requirements, review the Transcript Requirements section on the right.



Adding a College or University

1.Click Add a College or University.
2.Type and select your college or university. It may take several tries to find your school, especially if it 
shares its name with others or could be spelled differently. For example, if you attended "Saint John's 
University," you may need to try "Saint John," "St. John," or "St John" (no period) to bring the school up on 
the list. If you exhausted all options and it does not appear, select Can't find your school?
3.Select if you obtained (or plan to obtain) a degree from the selected institution.

1. If you earned or plan to earn a degree, provide details about the earned or expected degree.
2. If you have a double major, select the checkbox to enter your second major. Note that you can 

only enter one minor.
3. Click Add another Degree to add additional degrees for this same college or university.

4.Select your college's or university's term system. You can usually find this on the back of your official 
transcripts, or you can contact your college's registrar.

1. Term system refers to the type of hours your credits are worth, not the length of the term or how 
many terms a year your college or university offered.

2. If your transcript lists some courses as quarter and others as semester, enter the term type that is 
most common (i.e., if you have six quarter terms and two semester terms, enter quarter).

5.Select if you are still attending your institution. Enter dates of the first and last (if applicable) terms you 
attended. Be sure to only enter each college or university you attended once, regardless of gaps in your 
attendance there.
6.Click Save to complete the entry.



College Transcripts

Note: If at least one program the applicant selected requires an official 
transcript, the Download Transcript Request form button will be displayed. 
Applicants will see program-level information about whether or not they 

need to submit a transcript and if so, what type (official, unofficial or none)



Sending Transcripts

If Your Program Requires Official Transcripts:
For each college or university entered, click Order and select if you are ordering 
electronic transcripts (recommended) or submitting a transcript via 
mail. See Sending Official Transcripts to NursingCAS for more information.
Note that if you attended a foreign college or university – and depending on your 
program's requirements – you may be required to send a foreign 
evaluation. See Sending Official Transcripts to NursingCAS for more information.
If Your Program Requires Unofficial Transcripts:
For each college or university entered, click Upload and upload any associated 
transcripts.
If Your Program Doesn't Require Transcripts to be Submitted Through NursingCAS
Some programs choose this option when they want your transcripts mailed directly 
to their office. For each college or university entered, click View Requirements to 
see the program's requirements.

https://help.liaisonedu.com/NursingCAS_Applicant_Help_Center/Sending_Your_Official_Transcripts_and_Test_Scores_to_NursingCAS/Sending_Official_Transcripts_to_NursingCAS
https://help.liaisonedu.com/NursingCAS_Applicant_Help_Center/Sending_Your_Official_Transcripts_and_Test_Scores_to_NursingCAS/Sending_Official_Transcripts_to_NursingCAS


Transcript Entry
Your selected programs may have different 
requirements for transcript entry. For example, some 
programs may require that you enter all of your 
coursework, some may require that you enter only 
prerequisite coursework, and others might not require 
that you enter any coursework. To view each program's 
transcript requirements, scroll down to the Program 
Requirements section of the application's Transcript 
Entry page.



If Your Program Requires Full Transcript 
Entry:

Enter all the coursework you completed at all US and English Canadian colleges, or universities attended. 
See Foreign and French-Canadian Transcripts and Study Abroad or Overseas US Transcripts for guidelines 
on foreign coursework. Note the following:
•Reporting coursework accurately is your responsibility. Since credit values, grade values, and course 
subjects vary widely from school to school, your programs need some type of standardization so they can 
accurately compare applicants. This standardization is achieved by using your coursework to create a 
standard set of GPAs, ensuring you are compared to other applicants fairly and equally.
•Complete the Colleges Attended section before entering your courses.
•Report all courses on your transcripts, not just prerequisites. Be sure to include courses from which you 
withdrew, repeated courses, ungraded labs, test credits, gym courses, orientations or other non-graded 
courses.
•Use official copies of your transcripts. Coursework must exactly match your official transcripts; don't use an 
unofficial version, like a printout from your school's website. List your courses under the correct term, year, 
and class level. Department prefixes and course numbers must precisely match those on your transcripts.
•Enter courses under the institution where you originally took the course, exactly as they appear on the 
original school's transcript. Don't list courses under the school in which the credits were transferred. You 
may need to go back to your Colleges Attended and add a school to enter the transfer credits for.
•NursingCAS will verify your coursework entry for accuracy, and your application will be returned to you if 
there are any inconsistencies, which may result in delays in submitting your application.
Note that if you don't want to enter all your coursework yourself, our specialists can enter it for you for an 
additional fee. See the Professional Transcript Entry Service (PTE) topic for more information.



Entering prerequisite coursework is a 3-step process:
1.Visit the Program Materials section of your application to review each program's 
prerequisite coursework requirements. Programs that require prerequisites will have 
a Prerequisites tab where you can view this information.
2.Once you are familiar with the requirements, navigate to the Transcript Entry section and 
enter only the specific courses you have completed which match each program's prerequisite 
coursework requirements.
3.When you have finished entering your prerequisite coursework, return to the Program 
Materials section and visit each program's page to identify the courses that fulfill each 
program's requirements. To assign a prerequisite on the Prerequisites tab:

1. Click Assign Course.
2. Click the plus sign next to the course(s) that you believe fulfills the prerequisite. You 

can match multiple courses to one prerequisite, if applicable.
3. Click Save and Exit.

NursingCAS will provide a standard set of GPAs to your selected program(s).
Note that if any program you are applying to requires full transcript entry, then you must enter 
all of your coursework. You only need to input this information once, as it can be used for 
every program you are applying to. See the section above for more information.

If Your Program Requires Transcript Entry 
for Prerequisites Only:



Need More Transcript Entry Help?

Watch this video: 
https://help.liaisonedu.com/Application_M
aterials/Transcripts/Transcript_Entry_Video

https://help.liaisonedu.com/Application_Materials/Transcripts/Transcript_Entry_Video


Professional Transcript Entry Service (PTE)
Overview
If you prefer not to enter all your coursework yourself, the Professional Transcript Entry 
Service (PTE) specialists can enter it for you for an additional fee. This service is only available 
for completed coursework from accredited schools. Coursework from unlisted schools, foreign 
coursework, and planned/in-progress courses are ineligible for PTE and must be entered by 
you.
Note that the PTE specialists only enter the information listed on your official transcripts and 
do not correct errors for coursework you have already entered. If you entered coursework and 
made a mistake or did not report an institution, these errors will be communicated to you 
during the verification process, at which point it will be your responsibility to correct them.
Please refer to the Refunding/Withdrawing Your Application page for further payment 
policies.

Fees
Fees for PTE are as follows:
•1-3 transcripts: $75
•4-6 transcripts: $100
•7 or more transcripts: $150
These fees apply only to coursework entry and are in addition to regular application fees. Fee 
waivers and coupon codes are not available for PTE. Additionally, your PTE payment cannot be 
transferred to another cycle (e.g., re-applicants, applicants applying in multiple cycles, etc.).



Process
Turnaround Time

Once all the requirements are met, it may take up to 10 business days for transcript entry 
to be completed. Your application will not be given a Complete Date and moved into the 
verification queue until your coursework entry is approved, at which point it can take up to 
an additional 10 business days to be verified. Please keep these turnaround times and your 
program's deadline requirements in mind. We are not responsible for missed deadlines 
due to PTE procedures or turnaround times.

Reviewing and Approving Your Coursework Entry

You will receive a notification once your PTE is complete. You should then review the 
coursework entered by the PTE specialists to ensure it is accurate and approve the entry. 
You should also match your coursework to any required prerequisite courses in 
the Program Materials section before approving the entry.

If you find any issues with the coursework entry, email customer service to determine how 
to proceed. Wait for corrections to be confirmed and implemented before approving the 
coursework entry.

Once you approve your coursework entry (and complete all other application 
requirements), your application is given a Complete Date and placed in line for 
verification. Be sure to approve your coursework in a timely manner to avoid any delays in 
processing your application.

If you reapply in a future cycle, your PTE coursework will only carry forward if you submit 
your application and approve the PTE coursework entry in the current cycle.



Standardized Tests

You can self-report your Standardized Test scores or 
report tests you plan to take in the Standardized 

Tests section. Some of the programs you apply to may 
require you to report certain test scores; be sure to check 

with your programs to ensure you are completing all 
requirements.

Note that self-reporting your scores is not the same as 
providing official scores to your programs. If your 

programs require official test scores, see Sending Official 
Test Scores for more information.



Self-Reported Test Scores
Add a Test Score

1.Navigate to the Standardized Tests section.

2.Find the test you took in the list and click Add Test Score. In some cases, you may only 
be able to enter scores for certain tests.

3.Select Yes under Have you taken the test.

4.Enter the date you took the test.

5.Enter all applicable scores and test ID, if applicable.

6.Click Save This Test.

After submitting your application, you can continue to add new test entries to this section, 
but you cannot update or delete previous entries.

Add a Planned Test

1.Navigate to the Standardized Tests section.

2.Find the test you took in the list and click Add Test Score. In some cases, you may only 
be able to enter scores for certain tests.

3.Select No under Have you taken the test.

4.Enter the date you plan to take the test.

5.Enter your test ID, if applicable.

6.Click Save This Test.



Supporting 
Information
This section is used to collect 
supporting application information, 
such as evaluations (i.e., letters of 
reference), achievements, and 
certifications.



Achievements

In this section, you can enter any relevant professional or 
academic achievements in several categories, or types. Review 
the definitions below, consider the achievement you earned, 
and choose the category that you think best fits.
Although you can enter any achievements that you believe are 
relevant to your application, we recommend focusing on those 
achievements within the last 10 years and at the collegiate 
level and above.



Types of Achievements

Achievement Types

Awards

Awards received as a prize, such as trophies and 
medals.

Honors

Honors received as a special distinction for work done, 
including Dean's List and memberships in honor 
societies.



Adding an Achievement

1.Click Add An Achievement.
2.Select the type of achievement.
3.Enter the name of the achievement.
4.Enter the name of the organization that presented the achievement, if applicable.
5.Enter the issued date.
6.Enter a brief description, especially if the achievement is not clear based on its 
title. You can also note if any special circumstances surrounded it. If your 
achievement was awarded multiple times (e.g., Dean's List), use this field to explain 
that instead of creating multiple instances.
7.Click Save This Achievement. Your saved achievements will not display in any 
particular order, regardless of the order or dates you enter.
Note that once you submit your application, you cannot edit or remove your 
achievements; however, you can continue to add new achievements, as needed.



Licensure and Certifications

In this section, you can add any current professional 
licensure or certifications that you have. Note that 

NursingCAS does not verify the information entered 
here. Contact your individual programs to determine 
if they require official documentation of any licensure 

or certification listed in this section.



Add a Licensure or 
Certification
In this section, you can add any current professional 
licensure or certifications that you have. Note that 
NursingCAS does not verify the information entered 
here. Contact your individual programs to determine if 
they require official documentation of any licensure or 
certification listed in this section.



Adding a Licensure or Certification
Add a Licensure
1.Click Add a Licensure or Certification.
2.Select Licensure from the Type drop-down.
3.Select an option from the Type of License drop-down.
4.Enter the name of the organization that issued the license.
5.Enter the date on which the license was issued and the date it is valid to, if 
applicable.
6.Select the state the license was issued in.
7.Select if your licensure status is in good standing.
Add a Certification
1.Click Add a Licensure or Certification.
2.Select Certification from the Type drop-down.
3.Enter the type of certification.
4.Enter the name of the organization that issued the certification.
5.Enter an optional, brief description.
6.Enter the date the certification is valid to, if applicable.
Note that once you submit your application, you cannot edit or remove licenses and 
certifications; however, you can continue to add new ones, as needed.



Experiences

In this section, you can enter your professional experiences in several categories, or 
types. Review the definitions below, consider the duties you performed, and choose 
the category that you think best fits the experience.
Note that since each program's definitions and requirements vary, NursingCAS has 
no specific preference as to which category you choose. These categories are 
broadly based on feedback from various nursing programs and are not a 
comprehensive list of every type of experience. Your experience's individual job 
description and responsibilities should determine the category you select; however, 
it is not guaranteed that your experience will be accepted by every program in the 
way you categorize it.
If you have any questions about your experiences fulfilling an individual program's 
prerequisite requirements, contact that program directly.
Although you can enter any experiences that you believe are relevant to your 
application, we recommend focusing on those experiences within the last 10 years 
and at the collegiate level and above. Enter only current and in-progress 
experiences (not planned experiences), and check your program's requirements 
regarding documentation.



Types of Experiences
Employment
Paid work done outside of the health care field or a research 
lab; for example, a retail or restaurant job.
Patient/Healthcare Experience
Paid (Employment), unpaid, and volunteer work done within 
the health care field and/or in which were involved in patient 
care.
Community Enrichment
Volunteer work done outside of the health care field; for 
example, working for Habitat for Humanity, tutoring students, 
participating in or working for a fundraiser walk or blood drive, 
etc.



Adding an Experience
Please list your experiences in chronological order from most recent to least recent.
1.Click Add an Experience.
2.Select the appropriate experience type from the drop-down.
3.Enter information about the organization where the experience took place.
4.Enter information about your supervisor at the organization. This is a person that 
programs can contact to verify that this experience occurred. If the experience was 
a student-organized group and there was no advisor, list a member who can verify 
your experience.
5.Enter the date or date range in which the experience took place. Note that your 
experiences will not display on your application in any specific order, regardless of 
the dates entered.
6.Enter additional details about the experience, including the title of the experience 
and the time commitments. Enter the average weekly number of hours that you 
completed for this experience during the date range that you indicated.
7.Select Yes or No to indicate a release authorization to allow your selected 
programs to contact the organization.
8.Click Save & Continue.
Note that you cannot repeat hours between experience types. So, if position duties 
encompass more than one section, enter the position in both sections and divide 
the hours and duties accordingly.



Program Materials

The Program Materials section includes additional 
information and requirements for the programs you 
selected in the Add Program tab. Each program's 
requirements may vary, so it's important you review 
this section in detail.

Your selected programs appear on the left side of this 
page; click each program's name to begin your review. 
Note that depending on your program's requirements, 
you'll see one or more of the tabs outlined below.



Program Materials Components
Home
The Home tab contains the Program Details provided by each program at the start 
of the application cycle. It includes deadlines and other information specific to the 
program. Be sure to review this page carefully for any additional instructions, 
information, and/or requirements.
Questions
The Questions tab is only available for certain programs. Here, you can answer 
questions specific to each program. Questions may be multiple choice or open-
ended text boxes. Some programs require an additional essay. Contact each 
program directly if you have questions.
Select your answers for each question and then click Save. If copying a response 
into a text box, check for possible formatting changes. We suggest using simple 
formatting, as tabs, italics, multiple spaces, etc., will not be saved. To delineate 
paragraphs, type a double return between each paragraph.



Program Materials Components
Documents
The Documents tab is only available for certain programs. If applicable, you can 
upload documents that will only be visible to that particular program. Documents 
that do not have a red asterisk are optional and do not need to be uploaded for you 
to submit your application.
Contact the program directly if you have any questions about their specific 
requirements.
If your program provides a PDF form to fill out and upload in this section, you must 
save and upload it as an image. Depending on your computer's operating system, 
there may be multiple ways to do this; a Google search can point you in the right 
direction.
Once your application is submitted, you cannot re-upload, update, or edit the 
documents in any way; however, you can upload new documents.
References
The References tab is only available for certain programs that require you to submit 
references.



Letters of Evaluation
Before You Begin
References (sometimes called Letters of Evaluation, Letters of Reference, or Letters 
of Recommendation) are submitted by the references themselves; they cannot be 
completed or submitted by the applicant or another party on behalf of the 
reference. We are not responsible for verifying references' identities. If a 
discrepancy is found, we reserve the right to contact the appropriate individuals to 
investigate and to share the discrepancy with all programs.
Before getting started, consider the following:
•All references are submitted electronically by references using Letters by Liaison, 
our Recommender Portal.
•Research each program's requirements. You should determine whether your 
programs have specific requirements regarding reference roles or relationships 
before listing references on your application. Many programs have strict guidelines 
and completed references cannot be removed or replaced.
•Choose your references early in the application process to ensure they have 
adequate time to submit your reference.
•Prepare your references. Once you choose your references, be sure to inform 
them about the process and that they will be completing the reference 
electronically. We recommend getting their preferred email address and asking that 
they monitor that inbox for your reference request (which will come 
from nursingcasinfo@nursingcas.org), including any junk or spam folders.

https://help.liaisonedu.com/Letters_by_Liaison_Help_Center
mailto:nursingcasinfo@nursingcas.org


The Reference Process

When you request references, your reference receives an 
email request with a link to Letters by Liaison. References 
review your requests, and then accept, complete, or deny 
them. References may complete assessments such as writing 
essays, completing Likert scales, and/or uploading letters.
Once your reference completes your reference, you'll be 
notified via email. You can check the status of your reference 
requests in the Check Status tab of your application at any 
time.



Submitting a Reference Request
1.On the References tab, click Add Reference.
2.Enter the reference's full name and email address.
3.Select the date by which you would like this reference completed. This date 
should be before your program(s) deadline.
4.Enter a brief message or note for the reference.
5.Select whether you want to waive your right of access to the reference. 
See Waiver below.
6.Click the checkboxes to indicate your permission for us (and programs) to contact 
your references.
7.Click Save This Reference Request to submit it. Once you do so, an email is 
immediately sent to the reference.
8.Confirm with your references that they received the email notification.
9.Use the Check Status tab to monitor the status of your references. Completed 
references are marked as "Complete" and have a Complete Date listed. Follow up 
with your references if their references are still marked as "Requested" or 
"Accepted." It is your responsibility to ensure that reference requests are received 
and completed on time. We will not notify applicants about missing references.



Editing References

Resend the Reference Request
If you need to resend a request:
1.On the References tab, locate the request you wish to 
resend.
2.Click the pencil icon to edit the request.
3.Scroll to the bottom of the page and click Resend This 
Reference Request.
Change the Reference's Email Address
If you entered an incorrect email address for any references (or 
if any reference asks that you send the request to a different 
email address), you must delete these requests and then re-
add them with the correct email.



Waiving References
The Family Education Rights and Privacy Act of 1974 (FERPA) gives you the right to 
access references unless you choose to waive your right of inspection and review. 
Prior to requesting any references, you are required to indicate whether you wish 
to waive your rights. NursingCAS will release your decision to waive or not waive 
access to your references and designated programs. Your waiver decision serves the 
same purpose as a legal signature and is binding.
Selecting Yes indicates to programs that your reference completed their reference 
with the understanding that you would not be able to view it. This means you will 
not be able to see the content of the reference. Programs may view this type of 
reference as a more accurate representation of an applicant's qualifications.
Selecting No indicates to programs that your reference completed their reference 
with the understanding that you may choose to view it in the future. Selecting this 
option does not allow you to view your reference via the application. If you do not 
waive your right to view the reference, you may ask your reference for a copy of the 
reference. Programs may view this type of reference as a less accurate 
representation of an applicant's qualifications.
Once you make a selection, you can't change it, so consider the choices carefully.



Kira Assessment
Some programs may request or require that you complete a Kira Talent 
assessment, which is separate from your NursingCAS application. Kira 
Talent is a cloud-based, online video screening platform where your 
programs create virtual interview questions. Contact each program directly 
if you have questions.
To submit a Kira assessment:
1.Click Open Kira Assessment.
2.You will then be redirected to Kira Talent, where you can register and 
complete your assessment.
Once you complete the Kira assessment, return to your NursingCAS
application to verify that the section is marked complete. It can take up to 
one hour to update, and you may need to refresh the page.
Note: if your program's Kira assessment is optional, you can choose not to 
submit one by clicking I Do Not Want To Complete This Assessment.



Program Materials: Prerequisites
The Prerequisites tab is only available for certain programs. In it, you can assign 
courses you took (or plan to take) to fulfill the program's required prerequisites. You 
must complete Transcript Entry and Transcript Review in order to complete this 
section.
Note that assigning these courses does not necessarily mean you meet the 
program's prerequisite requirements; the program wants you to self-identify these 
courses for their review. Contact each program directly if you have questions about 
these prerequisites.
Assign a Prerequisite
1.Click Assign Course.
2.Click the plus sign next to the course(s) that you believe fulfills the prerequisite. 
You can match multiple courses to one prerequisite, if applicable. If you do not have 
a prerequisite course to add, click I Am Not Matching Any Courses to this 
Prerequisite.
3.Click Save and Exit.



Still have Questions?
For help with application-related questions, contact customer service by chat 

via the icon in the lower right corner, by phone at 617-612-2880, or by email 

at nursingcasinfo@nursingcas.org. Note the following:

•Hours of operation: Monday – Friday, 9 AM – 5 PM ET.

•For the quickest response, contact by chat.

•NursingCAS typically provide responses to emails within two business days; 

however, response times can take up to three business days when they are at 

their busiest.

•Be sure to have your CAS ID number (located under your name in the upper-

right corner of the application) when contacting NursingCAS.

mailto:nursingcasinfo@nursingcas.org


When You Should Contact a Program Directly
NursingCAS can assist with application-related questions. For all other 

inquiries, including the following, please contact your program directly:

•Admission requirements and policies

•Deadline requirements

•Prerequisites

•Supplemental materials

•Requirements regarding the identity of references

•Status of your application after it has been verified

•Admission decisions and interview questions

•Content and duration of a particular school’s program



Thank You

Casey Ellis

cme18@uga.edu

About Us | Pre-Health Advising Office (uga.edu)

mailto:cme18@uga.edu
https://ppao.uga.edu/about/advisors/
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